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Most of the materials in the presentation  Most of the materials in the presentation  
werederived from New Perspectives Excel 2003, werederived from New Perspectives Excel 2003, 

2nd Ed.2nd Ed.

XP

Tutorial 11Tutorial 11
Importing Data Into ExcelImporting Data Into Excel

XPImport data from Import data from 
a text file into Excela text file into Excel

►► Sometimes it is necessary to import data from another Sometimes it is necessary to import data from another 
source into an Excel worksheet. One possible source source into an Excel worksheet. One possible source 
of data is a text file. of data is a text file. 

►► A text file is a file without formulas, graphics, special A text file is a file without formulas, graphics, special 
fonts, or formatting. fonts, or formatting. 

►► A text file contains alphanumeric data, letters, A text file contains alphanumeric data, letters, 
numbers, and symbols like commas and tabs. numbers, and symbols like commas and tabs. 

►► Any structure the text file has must be supplied by Any structure the text file has must be supplied by 
some combination of text symbols. some combination of text symbols. 
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XPTypes of text filesTypes of text files

►► If the data is in columns, for instance, the column If the data is in columns, for instance, the column 
breaks must be indicated in some way. breaks must be indicated in some way. 

In some text files, the columns are separated by a In some text files, the columns are separated by a 
delimiter, such as a space, a comma, or a tab, that delimiter, such as a space, a comma, or a tab, that 
shows where one column of data ends and another shows where one column of data ends and another 
begins begins 

►► In other text files, the columns are fixedIn other text files, the columns are fixed--width, width, 
which means that in each column, all the data which means that in each column, all the data 
begins at a fixed place on the line. begins at a fixed place on the line. 

That is, in every row of data, the data in the first That is, in every row of data, the data in the first 
column starts at, say, the first space, the data in the column starts at, say, the first space, the data in the 
second column starts at the thirteenth space, and so on second column starts at the thirteenth space, and so on 

XPCommon text file delimitersCommon text file delimiters
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XPA fixedA fixed--width text filewidth text file

XPText Import WizardText Import Wizard

►► If you open a text file in Excel, Excel starts the Text If you open a text file in Excel, Excel starts the Text 
Import Wizard. Import Wizard. 

►► The Text Import Wizard takes you through three dialog The Text Import Wizard takes you through three dialog 
boxes: boxes: 

1.1. In the first dialog box you have to check whether the data is In the first dialog box you have to check whether the data is 
delimited or fixeddelimited or fixed--width. The Wizard will try to determine this width. The Wizard will try to determine this 
itself, but if it is wrong, you can set this manually itself, but if it is wrong, you can set this manually 

2.2. In the next dialog box, the Wizard helps you set up the breaks In the next dialog box, the Wizard helps you set up the breaks 
between the columns. The Wizard tries to detect the correct between the columns. The Wizard tries to detect the correct 
space to begin each column, but sometimes it cannot. When that space to begin each column, but sometimes it cannot. When that 
happens, you need to edit the column break lines manually happens, you need to edit the column break lines manually 

3.3. The final dialog box of the Text Import Wizard allows you to The final dialog box of the Text Import Wizard allows you to 
format the columns of data, one at a time. You can highlight format the columns of data, one at a time. You can highlight 
each column, and check off whether the column contains text or each column, and check off whether the column contains text or 
dates dates 
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XPText Import Wizard Text Import Wizard 
dialog box #1dialog box #1

XPText Import WizardText Import Wizard
dialog box #2dialog box #2
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XPModifications to the Modifications to the 
second text boxsecond text box

XPText Import Wizard Text Import Wizard 
dialog box #3dialog box #3
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XPAn example of an An example of an 
imported text fileimported text file

XPRetrieve data from Retrieve data from 
database tablesdatabase tables

►► Another possible source from which you could Another possible source from which you could 
import data into is a database. import data into is a database. 

►► A database is a program that can store large A database is a program that can store large 
amounts of data in tables.amounts of data in tables.

►► The rows in a database table are called records.The rows in a database table are called records.
►► The columns are called fields. The columns are called fields. 

Each record in the table contains the same fields Each record in the table contains the same fields 

Similar to a list in ExcelSimilar to a list in Excel
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XPWhat is a query?What is a query?

►► Excel can import data from most database tables. Excel can import data from most database tables. 
►► To get information from a database, you must To get information from a database, you must 

create a query. create a query. 
►► The query tells the database:The query tells the database:

What information you wantWhat information you want
Which records you want it fromWhich records you want it from
How you want the data arranged How you want the data arranged 

►► Excel has an addExcel has an add--in called the Query Wizard to in called the Query Wizard to 
help you write queries to extract data from a help you write queries to extract data from a 
database. database. 

XPStart the Query WizardStart the Query Wizard

►► To import data using the Query Wizard, from the To import data using the Query Wizard, from the 
Data menu, choose Import External Data, and Data menu, choose Import External Data, and 
from the submenu that appears, select New from the submenu that appears, select New 
Database Query. Database Query. 

►► This brings up the Query Wizard This brings up the Query Wizard -- Choose Data Choose Data 
Source dialog box.Source dialog box.

►► On the Databases tab of the dialog box you will On the Databases tab of the dialog box you will 
see a list of possible data sources. see a list of possible data sources. 

►► You choose the database type and proceed to the You choose the database type and proceed to the 
next step, which is to locate the database file to next step, which is to locate the database file to 
be imported.be imported.
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XPThe Choose Data Source The Choose Data Source 
dialog boxdialog box

XPSelect tables and fields to Select tables and fields to 
importimport

►► When you have located the database and clicked When you have located the database and clicked 
the OK button, the database opens the Query the OK button, the database opens the Query 
Wizard Wizard –– Choose Columns dialog box.Choose Columns dialog box.

►► In the In the Available tables and columns:Available tables and columns: box, you will box, you will 
see a list of the tables in the database. see a list of the tables in the database. 

►► You can see the columns (fields) in each table by You can see the columns (fields) in each table by 
clicking on the plus sign in front of the table. clicking on the plus sign in front of the table. 

►► From these fields, you can select the ones you From these fields, you can select the ones you 
want to import and add them to the Columns in want to import and add them to the Columns in 
your query: box. your query: box. 
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XPApply filters to import dataApply filters to import data

►► When you have selected all your fields, click the Next When you have selected all your fields, click the Next 
button to bring up the Query Wizard button to bring up the Query Wizard -- Filter Data dialog Filter Data dialog 
box.box.

►► When you are importing data from a database, you may When you are importing data from a database, you may 
want to filter the data by choosing some filtering criteria. want to filter the data by choosing some filtering criteria. 

►► To do this, in the Filter Data dialog box:To do this, in the Filter Data dialog box:
Click the column you wish to filterClick the column you wish to filter
Specify a comparison operatorSpecify a comparison operator
Enter the desired criterion in the appropriate box Enter the desired criterion in the appropriate box 

►► If you want to use all the data or if you have finished If you want to use all the data or if you have finished 
writing all your filters, click Next to go to the writing all your filters, click Next to go to the 
Query Wizard Query Wizard -- Sort By dialog box where you can specify Sort By dialog box where you can specify 
what sequence the data is to be sorted in. what sequence the data is to be sorted in. 

XPThe Filter Data dialog boxThe Filter Data dialog box
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XPSave and run the querySave and run the query

►► Your query is now defined. Your query is now defined. 
►► Click Next to bring up the final Query Wizard Click Next to bring up the final Query Wizard 

dialog box. dialog box. 
►► This dialog box allows you to save the query you This dialog box allows you to save the query you 

have just created, with a file extension of .dqy. have just created, with a file extension of .dqy. 
►► Now, you may choose the Now, you may choose the Return Data to Return Data to 

Microsoft Office ExcelMicrosoft Office Excel button. button. 
►► When you now select a cell in the worksheet, the When you now select a cell in the worksheet, the 

Query Wizard runs the query against the database Query Wizard runs the query against the database 
and inserts the data it extracts into the worksheet and inserts the data it extracts into the worksheet 
beginning at the selected cell. beginning at the selected cell. 

XPEditing queriesEditing queries

►► Excel knows when the data in a worksheet has Excel knows when the data in a worksheet has 
been imported from an external source, and been imported from an external source, and 
provides an External Data toolbar that makes provides an External Data toolbar that makes 
available several options. available several options. 

►► To bring up the External Data toolbar, first make To bring up the External Data toolbar, first make 
sure that your cursor is pointing to a cell sure that your cursor is pointing to a cell 
containing external data. containing external data. 

►► Choose Toolbars from the View menu, and choose Choose Toolbars from the View menu, and choose 
ExternalExternal Data in the subData in the sub--menu.menu.
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XP
The Refresh Data button The Refresh Data button 

When you click this, Excel goes to the data When you click this, Excel goes to the data 
source that the data was imported from, source that the data was imported from, 
and brings into the worksheet any changes and brings into the worksheet any changes 
that have occurred since the data was that have occurred since the data was 
loaded (or last refreshed)loaded (or last refreshed)

XPSet Data Range propertiesSet Data Range properties

►► Clicking the Data Range Properties button on the External Data Clicking the Data Range Properties button on the External Data 
toolbar brings up the External Data Range Properties dialog box.toolbar brings up the External Data Range Properties dialog box.

►► The name under which you saved the query that produced this The name under which you saved the query that produced this 
data appears in the Name: box.data appears in the Name: box.

►► You can save the query, and even save a password for the You can save the query, and even save a password for the 
query so that it cannot be changed unless the password is query so that it cannot be changed unless the password is 
entered. entered. 

►► You have several options about refreshing the data, about the You have several options about refreshing the data, about the 
data formatting and layout, and about what to do if the layout data formatting and layout, and about what to do if the layout 
of the source document has changed when you attempt to of the source document has changed when you attempt to 
refresh. refresh. 

►► Selecting the Selecting the Refresh data on file openRefresh data on file open check box will cause check box will cause 
Excel to query the data source for updated data every time the Excel to query the data source for updated data every time the 
file containing this worksheet is opened.file containing this worksheet is opened.
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XPExternal Data Range External Data Range 
PropertiesProperties

XPRetrieve data from a Retrieve data from a 
database into a PivotTabledatabase into a PivotTable

►► First, choose or create an empty worksheet. First, choose or create an empty worksheet. 
►► From the Data menu choose From the Data menu choose PivotTable and PivotChart PivotTable and PivotChart 

Report.Report.
►► When the Wizard comes up with the dialog box labeled When the Wizard comes up with the dialog box labeled 

Step 1 of 3, choose Step 1 of 3, choose External data sourceExternal data source and and PivotChart PivotChart 
report (with PivotTable report)report (with PivotTable report), then click Next. , then click Next. 

►► This will bring up Step 2 of 3 of the Wizard. Click the Get This will bring up Step 2 of 3 of the Wizard. Click the Get 
Data button. This will bring up the Query Wizard Data button. This will bring up the Query Wizard -- Choose Choose 
Data Source dialog box. Data Source dialog box. 

►► Choose the data source type, and click OK. Select your Choose the data source type, and click OK. Select your 
database from its folder on the Data Disk, and click OK. database from its folder on the Data Disk, and click OK. 
Select your table in the list of tables.Select your table in the list of tables.

If you click Add, the Query Wizard will add all of the columns iIf you click Add, the Query Wizard will add all of the columns in the n the 
selected table to the Columns in your query: box selected table to the Columns in your query: box 
If you do not want to filter or sort the data, you can click NexIf you do not want to filter or sort the data, you can click Next repeatedly t repeatedly 
until you have reached the end of the Query Wizard, and have retuntil you have reached the end of the Query Wizard, and have returned to urned to 
Step 2 of 3 in the PivotTable and PivotChart Wizard Step 2 of 3 in the PivotTable and PivotChart Wizard 
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XPSet the PivotTable layoutSet the PivotTable layout

►► Click Next to go to Step 3 of 3. Here, choose the Click Next to go to Step 3 of 3. Here, choose the 
Existing worksheet option, and click the cell where Existing worksheet option, and click the cell where 
you want to start the PivotTable.you want to start the PivotTable.

►► Click Layout, which will bring up a Layout dialog Click Layout, which will bring up a Layout dialog 
box, on which you will design the PivotTable. box, on which you will design the PivotTable. 

►► You can drag the buttons on the right side of the You can drag the buttons on the right side of the 
dialog box to the diagram on the left side.dialog box to the diagram on the left side.

►► You can change the words on the column labels You can change the words on the column labels 
by double clicking on the fields and using the by double clicking on the fields and using the 
Name text box. Name text box. 

►► Also, while you are in the PivotTable Field dialog Also, while you are in the PivotTable Field dialog 
box, you can format fields as a number.box, you can format fields as a number.

XPThe Layout dialog boxThe Layout dialog box



14

XPFinish the Pivot TableFinish the Pivot Table

►► In the Step 3 of 3 dialog box, you can click In the Step 3 of 3 dialog box, you can click 
Options so that selected columns or rows are not Options so that selected columns or rows are not 
selected. selected. 

►► You should also select You should also select Refresh on openRefresh on open in this in this 
dialog box.dialog box.

►► Click OK and Finish.Click OK and Finish.
►► You have designed a PivotTable and PivotChart, You have designed a PivotTable and PivotChart, 

and a query to get the data to go in them. and a query to get the data to go in them. 
►► The PivotTable will be on a worksheet called The PivotTable will be on a worksheet called 

Recent Results; the PivotChart will be on a sheet Recent Results; the PivotChart will be on a sheet 
called Chart1 for the example created here.called Chart1 for the example created here.

XPExample PivotTable and Example PivotTable and 
PivotChartPivotChart
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XPRetrieve stock market Retrieve stock market 
data from the Webdata from the Web

►►To access a Web page, you must know the To access a Web page, you must know the 
URL. URL. 

►►The URL of a Web page is its address, the The URL of a Web page is its address, the 
place the network browser goes to find the place the network browser goes to find the 
page. page. 

►►Web pages stored on the Web usually Web pages stored on the Web usually 
(although not always) have a URL that (although not always) have a URL that 
starts with http://www. starts with http://www. 

►►Web pages can also be accessed from a disk Web pages can also be accessed from a disk 
instead of from the Web. instead of from the Web. 

XPBegin the Query WizardBegin the Query Wizard

►►To create a Web query, find or create a new To create a Web query, find or create a new 
worksheet in your Excel workbook.worksheet in your Excel workbook.

►►Point to the cell where you want the Point to the cell where you want the 
imported information to start.imported information to start.

►►From the Data menu, choose Import From the Data menu, choose Import 
External Data, and then New Web Query. External Data, and then New Web Query. 

►►The Query Wizard will invoke your Web The Query Wizard will invoke your Web 
browser, and open your home or default browser, and open your home or default 
Web page. Web page. 

►►Type in the address of the HTML file to be Type in the address of the HTML file to be 
used. used. 
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XPImport the Web page dataImport the Web page data

►► When the Web page is opened with the Query Wizard, the When the Web page is opened with the Query Wizard, the 
Wizard puts little selection arrows in front of each section. Wizard puts little selection arrows in front of each section. 

►► As you click on the sections you want to import, the arrow As you click on the sections you want to import, the arrow 
changes to a check mark. changes to a check mark. 

►► There is a selection arrow at the top of the page; you There is a selection arrow at the top of the page; you 
select this arrow to select the entire page. select this arrow to select the entire page. 

►► Click on the arrows that point to the tables on the Web Click on the arrows that point to the tables on the Web 
page, and then click Import.page, and then click Import.

►► Check the address in the Import Data dialog box, and click Check the address in the Import Data dialog box, and click 
OK.OK.

►► The Query Wizard has created a query to select the parts The Query Wizard has created a query to select the parts 
of the Web page you want, and has imported the data into of the Web page you want, and has imported the data into 
your worksheet. your worksheet. 

XPImport pages with HTML Import pages with HTML 
formatting retainedformatting retained

►► One of the options on the External Data toolbar is One of the options on the External Data toolbar is 
to to Edit QueryEdit Query. . 

►► You can edit the query to import the data with all You can edit the query to import the data with all 
its HTML formatting features, such as complicated its HTML formatting features, such as complicated 
table structures, and hyperlinks. table structures, and hyperlinks. 

►► From the Edit Web Query page, select Options, From the Edit Web Query page, select Options, 
and from the Web Query Options page, select and from the Web Query Options page, select Full Full 
HTML formattingHTML formatting. Select OK, and then Import.. Select OK, and then Import.

►► You can save a Web query, and then use it in any You can save a Web query, and then use it in any 
Excel workbook To do so:Excel workbook To do so:

Select the Edit Query button from the External Data toolbar, andSelect the Edit Query button from the External Data toolbar, and
select the Save Query button select the Save Query button 
Key in the path to the folder where you want the query to be Key in the path to the folder where you want the query to be 
saved, and give it a namesaved, and give it a name
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XPAn imported Web page An imported Web page 
with its HTML formattingwith its HTML formatting

XPImport stock quotesImport stock quotes

►►There are some Web queries that Microsoft There are some Web queries that Microsoft 
provides for you. One of these is the provides for you. One of these is the 
Microsoft Investor Stock Quotes query. Microsoft Investor Stock Quotes query. 

►►From the Data menu, choose Import From the Data menu, choose Import 
External Data, then choose Import Data. External Data, then choose Import Data. 

►►This will bring up the Select Data Source This will bring up the Select Data Source 
dialog box, where you will see a list of dialog box, where you will see a list of 
available queries. available queries. 

►►Choose Choose MSN MSN MoneyCentralMoneyCentral Investor Stock Investor Stock 
QuotesQuotes, and click Open. , and click Open. 



18

XPEnter parameters for the Enter parameters for the 
Stock Quote queryStock Quote query

►► In the Import Data dialog box, click Parameters.In the Import Data dialog box, click Parameters. In the In the 
Parameters dialog box, notice that you can choose Parameters dialog box, notice that you can choose Get the value Get the value 
from the following cell:,from the following cell:, and then enter a cell address or range. and then enter a cell address or range. 

►► If you have already imported the list of ticker symbols for a liIf you have already imported the list of ticker symbols for a list st 
of stocks into a worksheet, you can read the ticker symbols fromof stocks into a worksheet, you can read the ticker symbols from
that worksheet. that worksheet. 

►► Click Click Get the value from the following cell:,Get the value from the following cell:, click Collapse Dialog click Collapse Dialog 
Box, open the worksheet where the ticker symbols are listed, Box, open the worksheet where the ticker symbols are listed, 
highlight them, and press Enter.highlight them, and press Enter.

►► Click OK twice to activate the Web query. If you have an open Click OK twice to activate the Web query. If you have an open 
connection to the Web, the query will get and display the connection to the Web, the query will get and display the 
current stock information for the stocks whose ticker symbols current stock information for the stocks whose ticker symbols 
you entered. you entered. 

XPStock quotes imported Stock quotes imported 
from the Webfrom the Web
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XPUse hyperlinksUse hyperlinks

►►Sometimes text from a Web page is Sometimes text from a Web page is 
underlined in blue. underlined in blue. 

►►This indicates that the text is a This indicates that the text is a hyperlinkhyperlink. . 
►►A hyperlink is any text or spot on a page A hyperlink is any text or spot on a page 

that, when you click on it, takes you to that, when you click on it, takes you to 
another location. another location. 

XPA worksheet with hyperlinksA worksheet with hyperlinks


